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Safety Instructions 

Before using the product … 
 
For your safety and effective operation, please read the safety instructions 
thoroughly before using the product. 
 
► Safety Instructions should always be observed in order to prevent accident 

or risk with the safe and proper use the product. 
 
► Instructions are separated into “Warning” and “Caution”, and the meaning of 

the terms is as follows; 
 

This symbol indicates the possibility of serious injury 
or death if some applicable instruction is violated  

 
This symbol indicates the possibility of slight injury 
or damage to products if some applicable instruction 
is violated  

 
► The marks displayed on the product and in the user’s manual have the 

following meanings. 

Be careful! Danger may be expected. 

Be careful! Electric shock may occur. 
 
► The user’s manual even after read shall be kept available and accessible to 

 any user of the product. 

Warning 

Caution 



 

Safety Instructions 

Safety Instructions when designing 
 

 

 

 

 

 

 

 

 

 

 

 Please, install protection circuit on the exterior of PLC to protect 
   the whole control system from any error in external power or PLC 

 module. Any abnormal output or operation may cause serious problem 
 in safety of the whole system.  

- Install applicable protection unit on the exterior of PLC to protect 
the system from physical damage such as emergent stop switch, 
protection circuit, the upper/lowest limit switch, forward/reverse 
operation interlock circuit, etc. 

- If any system error (watch-dog timer error, module installation error, 
etc.) is detected during CPU operation in PLC, the whole output is 
designed to be turned off and stopped for system safety. However, 
in case CPU error if caused on output device itself such as relay or 
TR can not be detected, the output may be kept on, which may 
cause serious problems. Thus, you are recommended to install an 
addition circuit to monitor the output status. 

 

 Never connect the overload than rated to the output module nor 
 allow the output circuit to have a short circuit, which may cause a 
 fire. 
 

 Never let the external power of the output circuit be designed to 
  be On earlier than PLC power, which may cause abnormal output or 

operation. 
 

 In case of data exchange between computer or other external 
equipment and PLC through communication or any operation of 
PLC (e.g. operation mode change), please install interlock in the 
sequence program to protect the system from any error. If not, it 
may cause abnormal output or operation. 

Warning 



 

Safety Instructions 

Safety Instructions when designing 
 

 

 

 

 

 

 
 

Safety Instructions when designing 

 I/O signal or communication line shall be wired at least 100mm 
  away from a high-voltage cable or power line. If not, it may cause 
 abnormal output or operation. 

Caution 

 Use PLC only in the environment specified in PLC manual or 
general standard of data sheet. If not, electric shock, fire, abnormal 
operation of the product or flames may be caused. 

 

 Before installing the module, be sure PLC power is off. If not, 
electric shock or damage on the product may be caused. 

 

 Be sure that each module of PLC is correctly secured. If the 
product is installed loosely or incorrectly, abnormal operation, error or 
dropping may be caused. 

 

 Be sure that I/O or extension connecter is correctly secured. If 
not, electric shock, fire or abnormal operation may be caused. 

 

 If lots of vibration is expected in the installation environment, 
don’t let PLC directly vibrated. Electric shock, fire or abnormal 
operation may be caused. 

 

 Don’t let any metallic foreign materials inside the product, which 
may cause electric shock, fire or abnormal operation.. 

Caution 



 

Safety Instructions 

Safety Instructions when wiring 
 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Prior to wiring, be sure that power of PLC and external power is 
turned off. If not, electric shock or damage on the product may be 
caused. 

 
 Before PLC system is powered on, be sure that all the covers of 
the terminal are securely closed. If not, electric shock may be caused 

Warning 

 Let the wiring installed correctly after checking the voltage rated 
of each product and the arrangement of terminals. If not, fire, 
electric shock or abnormal operation may be caused. 

 

 Secure the screws of terminals tightly with specified torque when 
wiring. If the screws of terminals get loose, short circuit, fire or abnormal 
operation may be caused. 

 
 Surely use the ground wire of Class 3 for FG terminals, which is 
exclusively used for PLC. If the terminals not grounded correctly, 
abnormal operation may be caused. 

 

 Don’t let any foreign materials such as wiring waste inside the 
module while wiring, which may cause fire, damage on the product 
or abnormal operation. 

Caution 



 

Safety Instructions 

Safety Instructions for test-operation or repair 
 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Safety Instructions for waste disposal 
 

 

 

 

 

 

 Don’t touch the terminal when powered. Electric shock or abnormal 
operation may occur. 

 

 Prior to cleaning or tightening the terminal screws, let all the 
external power off including PLC power. If not, electric shock or 
abnormal operation may occur. 

 

 Don’t let the battery recharged, disassembled, heated, short or 
soldered. Heat, explosion or ignition may cause injuries or fire. 

Warning 

 Don’t remove PCB from the module case nor remodel the module. 
Fire, electric shock or abnormal operation may occur. 

  
 Prior to installing or disassembling the module, let all the external 
 power off including PLC power. If not, electric shock or abnormal 
operation may occur. 

 

 Keep any wireless installations or cell phone at least 30cm away 
from PLC. If not, abnormal operation may be caused. 

Caution 

 Product or battery waste shall be processed as industrial waste. 
The waste may discharge toxic materials or explode itself. 

Caution 
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About User’s Manual 
 
 

About User’s Manual 
 

Congratulations on purchasing PLC of LS Industrial System Co.,Ltd. 

Before use, make sure to carefully read and understand the User’s Manual about the functions, 

performances, installation and programming of the product you purchased in order for correct use and 

importantly, let the end user and maintenance administrator to be provided with the User’s Manual.  

 

The Use’s Manual describes the product. If necessary, you may refer to the following description and order 

accordingly. In addition, you may connect our website(http://www.lsis.biz/) and download the information as a 

PDF file.  

 

Relevant User’s Manuals 

Title Description 
No. of User’s 

Manual 

XGK-CPUA/CPUE/CPUH/CPUS 

It describes specifications, system structure and EMC 

spec. correspondence of CPU module, power module, 

base, I/O module and increase cable 

10310000508

XG5000 User’s Manual 

It describes how to use XG5000 software especially 

about online functions such as programming, printing, 

monitoring and debugging by using XGT series 

products. 

10310000512

XGK Series  

Instructions & Programming 

It is the user’s manual for programming to explain how 

to use commands that are used PLC system with XGK 

CPU. 

10310000510
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Chapter 1 Introduction 
Voltage output is called as XGF-DV4A/DV8A, and current output is as XGF-DC4A/DV8A in this product. 
Analog output module is used to convert the digital value of signed 16-bit binary data (data: 14 bits) 
specified in PLC CPU to analog signal (voltage or current output). 

 
1) D/A conversion of 4/8 channels is available with one module. 

XGF-DV4A/DV8A: D/A conversion of 4/8 channels (voltage output) is available with one 
module. 
XGF-DC4A/DC8A: D/A conversion of 4/8 channels (current output) is available with one 
module. 

  
2) High resolution of 1/16000  

Through the digital value resolution of1/16000, high resolution of analog value can be obtained. 
  

3) High accuracy 
High accuracy of ±0.2% or less (when ambient temperature is 25℃). 

  
4) Conversion process at high speed  

Conversion speed is 250㎲/channel. 
  

5) Various output ranges available 
XGF-DV4A/DV8A: 1~5V, 0~5V, 0~10V, -10~10V 
XGF-DC4A/DC8A: 4~20mA, 0~20mA 

  
6) The number of modules used for one base is not limited. 

(However, it should be within the capacity of the power module.) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Characteristics 
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1.2 Terminology 
                 

1.2.1 Analog quantity − A 
 
 
 
 
 
 
 
 
 
 
Such a quantity continuously changed is called Analog Quantity as voltage, current, temperature, 
speed, pressure and flow. For example, temperature can change continuously together with time as 
shown in Fig. 1.1. Since the changing temperature can not be input directly on PLC, it should be 
input on PLC through the transducer converting to identical analog quantity of DC voltage －10 
~+10V or current  4~20 ㎃. 

 
1.2.2 Digital quantity − D 

 
Such a quantity discontinuously changed is called Digital Quantity 
as displayed in figures of 0, 1, 2 and 3. For example, On and Off 
signal can be displayed in a digital quantity of 0 and 1. BCD and 
binary value is also the digital quantity 

 
 
 
 

Analog quantity can not be directly input on PLC CPU for 
calculation of the digital quantity. Thus, convert analog quantity 
to digital quantity as in Fig. 1.4 so to input on CPU. In addition, 
in order to output the analog quantity outward, convert CPU’s 
digital quantity to analog quantity. 
 
 
 
 
 

[Fig 1.3] Digital Quantity 
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[Fig 1.4] Process in PLC 
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1.2.3 Characteristics of D/A conversion 
1) Voltage output  

 
 
 
 
 
 
 
 
 
 
 
 
  
 

Analog output module is used to convert digital quantity output from CPU to analog value so to 
output to the external device. When the voltage output range of Analog output module is in 
-10~10V, -10V will be output if digital quantity of 0 is input. And 10V will be output if digital quantity 
of 16000 is input, where analog quantity converted from digital input of 1 is equivalent to 1.25㎷. 
 
 
2) Current output  

 
 
 
 
 
 
 
 
 
 
 

 
 
 
When the current output range of Analog output module is in 4~20mA, 4mA will be output if digital 
quantity of 0 is input. And 20mA will be output if digital quantity of 16000 is input, where analog 
quantity converted from digital input of 1 is equivalent to 1㎂. 
 
 
 
 
 
 
 

[Fig. 1.5] Characteristics of D/A conversion (voltage output)  

[Fig. 1.6] Characteristics of D/A conversion (current output)  

A
nalog output current 

12㎃ 

4㎃ 
0 8000 16000

Digital input value 

8008000 8001 8002 8003

Digital input 

A
nalog output current 800

12.001㎃

12.000㎃

1㎂ 

20㎃ 

A
nalog output voltage 

10V 

0V 

-10V 

0 8000 16000

Digital input value 

8004 8001 8002 8003 

Digital input 
A

nalog output voltage 

8005 

0.00125

0.000V

1.25㎷

8000



Chapter 2 Specifications 
 

2 - 1 

 
Chapter 2 Specifications 

General specifications of XGT series are as specified below. 

No. Items  Specifications Related 
standards 

1 
Ambient 

temperature 
0 ~ 55 °C  

2 
Storage 

temperature 
−25 ~ +70 °C  

3 
Ambient 
humidity 5 ~ 95%RH (Non-condensing)  

4 
Storage 
humidity 

5 ~ 95%RH (Non-condensing)  

Occasional vibration -  
Frequency Acceleration Amplitude times 

10  ≤  f  <  57Hz − 0.075mm 
57  ≤  f  ≤  150Hz 9.8m/s2(1G) − 

Continuous vibration 
Frequency Acceleration Amplitude 

10  ≤  f  <  57Hz − 0.035mm 

5 
Vibration 

resistance 

57  ≤  f  ≤  150Hz 4.9m/s2(0.5G) − 

10 times 
each 

directions  
(X, Y and Z) 

IEC61131-2

6 
Shock 

resistance 

• Peak acceleration: 147 m/s2(15G) 
• Duration: 11ms 
• Half-sine, 3 times each direction per each axis 

IEC61131-2

Square wave 
Impulse noise 

±1,500 V LSIS standard

Electrostatic 
discharge 

4kV (Contact discharge) 
IEC61131-2

IEC61000-4-2
Radiated 

electromagnetic 
field noise 

80 ~ 1,000 MHz,  10V/m IEC61131-2,
IEC61000-4-3

Segm
ent 

Power supply 
module 

Digital/analog input/output 
communication interface 

7 
Noise 

resistance 

Fast 
transient/bust 

noise Voltage 2kV 1kV 

IEC61131-2
IEC61000-4-4

8 Environment Free from corrosive gasses and excessive dust  

9 Altitude  Up to 2,000 ms  

10 
Pollution 
degree 2 or less  

11 Cooling Air-cooling  
 

N0ote  
 1) IEC (International Electrotechnical Commission): 
   An international nongovernmental organization which promotes internationally cooperated standardization in  

electric/electronic field, publishes international standards and manages applicable estimation system related with. 
 2) Pollution degree:  

An index indicating pollution degree of the operating environment which decides insulation performance of the 
devices. For instance, Pollution degree 2 indicates the state generally that only non-conductive pollution occurs. 
However, this state contains temporary conduction due to dew produced. 

 2.1 General Specifications 
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2.2 Performance Specifications 

 
Performance specifications of Analog output module are as specified in table below. 

Specification 
Item XGF-DV4A 

(Voltage Output Type)
XGF-DV8A 

(Voltage Output Type)
XGF-DC4A  

(Current Output Type) 
XGF-DC8A  

(Current Output Type)
DC 4 ~ 20 ㎃ 
DC 0 ~ 20 ㎃ 

DC  1 ~ 5V 
DC  0 ~ 5V 

 DC  0 ~ 10V 
DC -10 ~ 10V 

Load resistance 
:600Ω or less 

Load resistance 
:550Ω or less Analog output 

Output range can be selected through applicable program or parameters  
(for respective channels) 

Digital input 

  
Signed 16-bit binary value (data: 14 bits) 
 : Format of input data can be set through applicable program or parameters  

(for respective channels) 
 

Analog output
Digital input 1 ~ 5V 0 ~ 5V 0 ~ 10V -10 ~ 10V 

Unsigned Value 0 ~ 16000 
Signed Value -8000 ~ 8000 
Precise Value 100 ~ 5000 0 ~ 5000 0 ~ 10000 -10000~10000

Percentile Value 0 ~ 10000 
  

Analog output
Digital input 4 ~ 20mA 0 ~ 20mA 

Unsigned Value 0 ~ 16000 
Signed Value -8000 ~ 8000 
Precise Value 4000 ~ 20000 0 ~ 20000 

Percentile Value 0 ~ 10000  

1/16000 (for respective output ranges) 
1~5 V 0.250 ㎷ 
0~5 V 0.3125 ㎷ 

4~20 ㎃ 1.0 ㎂ 

0~10 V 0.625 ㎷ 

Maximum resolution 

±10 V 1.250 ㎷ 
0~20 ㎃ 1.25 ㎂ 

Accuracy ±0.2% or less (when ambient temperature is 25 )℃  
±0.3% or less (when the range is within operational temperature) 

Maximum conversion 
speed 250 ㎲/channel 

Absolute maximum 
output ±15 V ±24 ㎃ 

Number of output 
channels 

4 channels/ 
1 module 

8 channels/ 
1 module 

4 channels/ 
1 module 

8 channels/ 
1 module 

Insulation method Photo-coupler insulation between input terminal and PLC power  
(no insulation between channels) 

Terminal connected 18-point terminal 

I/O points occupied Changeable type: 16 points, Fixed type: 64 points 

DC 5V 190 ㎃ 190 ㎃ 190 ㎃ 190 ㎃ Current 
consumption DC 24V 140 ㎃ 180 ㎃ 210 ㎃ 300 ㎃ 

Weight (g) 150g 

Load resistance 
: 1 ㏀ or more
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2.3 Respective Designations and Functions 
 
Respective designations of the parts are as described below.  
 
 

                               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

No. Description 

RUN LED  
① 

Displays the operation status of Analog output module  
   On: Operation normal 
   Blinks: Error occurs (Refer to 7.1 for more details) 

 Off: DC 5V disconnected, Analog output module error 

Analog Terminal  
 

② 

 
Analog terminal, whose respective channels can be connected with external devices 

Power Terminal  ③ 

 
Supply terminal of external power DC24V (No.17~18) 

 

② 

① 

  

③ 

XGF-DV4A XGF-DC4A 
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2.4 Characteristics of I/O Conversion 
 

Characteristics of I/O conversion are displayed in a straight line with the inclination as shown below 

when converting digital signal specified in PLC to analog signal (voltage or current). 

Input formats of digital data are classified into Unsigned Value, Signed Value, Precise Value and 

Percentile Value, and I/O conversion characteristics for respective digital input ranges are as described 

below. 

  

2.4.1 Characteristic of voltage output 
 

        Voltage output range can be selected through user program or special module parameters setting for 
respective channels.  

 

 
1) If the range is 1~5V  
 

Analog Voltage Output  
Digital Input 

0.952 1.0 2.0 3.0 4.0 5.0 5.048 

Max. 
Resolu

tion 

Unsigned value -192 0 4000 8000 12000 16000 16191 

Signed value -8192 -8000 -4000 0 4000 8000 8191 

Precise value 952 1000 2000 3000 4000 5000 5047 

Percentile value -120 0 2500 5000 7500 10000 10119 

0.25 ㎷

※ In the case of 1~5V voltage output, analog voltage output for digital value of “1” is equivalent to 0.25 ㎷. 
 
 

Digital Input Value 

An
al

og
 V

ol
ta

ge
 O

ut
pu

t 
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2) If the range is 0~5V  
 

Analog Voltage Output 
Digital Input 

-0.06 0.0 1.25 2.5 3.75 5.0 5.06 
Maximum
Resolution

Unsigned value -192 0 4000 8000 12000 16000 16191 

Signed value -8192 -8000 -4000 0 4000 8000 8191 

Precise value -60 0 1250 2500 3750 5000 5059 

Percentile value -120 0 2500 5000 7500 10000 10119 

0.3125 ㎷ 

※ In the case of 0~5V voltage output, analog voltage output for digital value of “1” is equivalent to 0.3125 ㎷. 
 
 
3) If the range is 0~10V  
 

Analog Voltage Output 
Digital Input 

-0.12 0.0 2.5 5.0 7.5 10.0 10.12 
Maximum
Resolution

Unsigned value -192 0 4000 8000 12000 16000 16191 

Signed value -8192 -8000 -4000 0 4000 8000 8191 

Precise value -120 0 2500 5000 7500 10000 10119 

Percentile value -120 0 2500 5000 7500 10000 10119 

0.625 ㎷ 

※ In the case of 0~10V voltage output, analog voltage output for digital value of “1” is equivalent to 0.625 ㎷. 
 

 
4) If the range is -10~10V  
 

Analog Voltage Output 
Digital Input 

-10.24 -10.0 -5.0 0.0 5.0 10.0 10.24 
Maximum
Resolution

Unsigned value -192 0 4000 8000 12000 16000 16191 

Signed value -8192 -8000 -4000 0 4000 8000 8191 

Precise value -10240 -10000 -5000 0 5000 10000 10238 

Percentile value -120 0 2500 5000 7500 10000 10119 

1.25 ㎷ 

※ In the case of -10~10V voltage output, analog voltage output for digital value of “1” is equivalent to 1.25 ㎷. 
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2.4.2 Characteristic of current output 
  

Current output range can be selected through user program or special module parameters setting for 
respective channels. 

 
 
 

1) If the range is 4~20㎃   
 

Analog Current Output 
Digital Input 

3.808 4 8 12 16 20 20.192 
Maximum
Resolution

Unsigned value -192 0 4000 8000 12000 16000 16191 

Signed value -8192 -8000 -4000 0 4000 8000 8191 

Precise value 3808 4000 8000 12000 16000 20000 20192 

Percentile value -120 0 2500 5000 7500 10000 10119 

1.0 ㎂ 

※ In the case of 4~20 ㎃ current output, analog current output for digital value of “1” is equivalent to 1.0 ㎂. 

 
2) If the range is 0~20㎃  
 

Analog Current Output 
Digital Input 

- 0 5 10 15 20 20.24 
Maximum
Resolution

Unsigned value 0 0 4000 8000 12000 16000 16191 

Signed value 0 -8000 -4000 0 4000 8000 8191 

Precise value 0 0 5000 10000 15000 20000 20192 

Percentile value 0 0 2500 5000 7500 10000 10119 

1.25 ㎂ 

※ In the case of 0~20 ㎃ current output, analog current output for digital value of “1” is equivalent to 1.25 ㎂. 
 

Digital Input Value 
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pu

t 
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2.4.3 Accuracy 

Although the output range is changed, the accuracy for the analog output value does not change. 
Fig. 2.1 shows the accuracy change range at the ambient temperature of 25 ± 5 ℃.  The analog 
output range is set between 4 to 20 mA and an unsigned integer is selected for the input type. 
(±0.2% at 25 ± 5 ℃, ±0.3% at 0 ~ 55 ℃) 

 

0
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8000

20mA

16000

Analog Output Value
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15968

16032

-32

32

 
          [Fig 2.1] Accuracy 
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2.5 Main Functions  
 

2.5.1 Output status setting 
 

1) Normal Mode 
 

Channel CPU status Output Status 
Run Stop 

Remarks 

Enable Digital Input Value 0V or 0 ㎃ 
RUN 

Disable As specified Setting 
output type 0V or 0 ㎃ 

Enable As specified Setting 
output type 0V or 0 ㎃ 

STOP 
Disable As specified Setting 

output type 0V or 0 ㎃ 

0 : previous value kept 
1 : minimum value output 
2 : middle value output 
3 : maximum value output

 
2) Test Mode 
 

Channel CPU status Output Status 
Run Stop 

Remarks 

Enable Digital Input Value 0V or 0 ㎃ 
STOP 

Disable As specified Setting 
output type 0V or 0 ㎃ 

0 : previous value kept 
1 : minimum value output
2 : middle value output 
3 : maximum value output

※ Test Mode is available only when CPU is in STOP status. 
 
3) If any DA module error occurs 
 

Channel CPU status Output Status 
Run Stop 

Remarks 

Enable Digital Input setting 
error Note1) 0V or 0 ㎃ 

RUN 
Disable As specified  

Setting output type 0V or 0 ㎃ 

Enable As specified  
Setting output type 0V or 0 ㎃ 

STOP 
Disable As specified  

Setting output type 0V or 0 ㎃ 

When Power is on /H/W error 0V or 0 ㎃ 

0 : previous value kept 
1 : minimum value output 
2 : middle value output 
3 : maximum value output

        
Note1) Digital Input setting error: upper limit or lower limit, Parameter setting error: as specified CH output type 

  
4) If any CPU error occurs  
 

Channel 
CPU status Output Status 

Run Stop 

Enable 
ERROR 

Disable 
0V or 0 ㎃ 
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2.5.2 Display and diagnosis functions   
 

  1) Run LED: displays the operation status of Analog output module 
• On: Operation normal 
• Blinks: Error occurs (Refer to Error Status below) 
• Off: DC 5V disconnected or module error 

  
  

  2) Error status: classifies and sorts errors identified during the module operation. 
 

Classification Error Details LED 

Internal memory error Blinks every 200 ms 
H/W System error 

ASIC I/F error Blinks every 200 ms 

Parameters setting Output status setting error Blinks every 1 sec. 
S/W 

Offset/Gain adjustment Offset/Gain setting error  Blinks every 1 sec. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Remark  

1) When Analog output module is released from the factory, Offset/Gain value is as adjusted for respective 
analog output ranges, which is unavailable for user to change. 
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Chapter 3 Installation and Wiring 

3.1.1 Installation environment 
This product is of high reliance regardless of installation environment. However, for the sake of 
reliance and stability of the system, please pay attention to those precautions described below. 

 
     1) Environmental conditions 

- To be installed on the control panel waterproof and dustproof. 
- No continuous impact or vibration shall be expected. 
- Not to be exposed to the direct sunlight. 
- No dew shall be caused by rapid temperature change. 
- Ambient temperature shall be kept 0-55 . ℃  

 
2) Installation  

- No wiring waste is allowed inside PLC when wiring or drilling screw holes. 
- To be installed on a good location to work on. 
- Don’t let it installed on the same panel as a high-voltage device is on. 
- Let it kept at least 50㎜ away from duct or near-by module. 

- To be grounded in an agreeable place free from noise. 
 

3.1.2 Precautions for handling  
Precautions for handling Analog output module are as described below from the opening to the 
installation. 
 
1) Don’t let it dropped or shocked hard. 
2) Don’t remove PCB from the case. It will cause abnormal operation 
3) Don’t let any foreign materials including wiring waste inside the top of the module when 

wiring. Remove foreign materials if any inside. 
4) Don’t install or remove the module while powered on. 

 

 
3.2.1 Precautions for wiring 

  
1) Use a cable for external output sign of Analog output module separate from the alternating 

current so to be free from surge or inductive noise produced from the alternating current side. 

2) Cable shall be selected in due consideration of ambient temperature and allowable current, 
whose size is not less than the max. cable standard of AWG22 (0.3㎟).  

3) Don’t let the cable too close to hot device and material or in direct contact with oil for long, 
which will cause damage or abnormal operation due to short-circuit. 

4) Check the polarity before external power is supplied to the terminal. 

5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal 
operation or defect. 

 

3.1 Installation 

3.2 Wiring 
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3.2.2 Wiring examples 

1) XGF-DV4A/DV8A 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2) XGF-DC4A/DC8A 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
∗ 1 : Use a 2-core twisted shielded wire. 
 
 
 

1 
2 

D/A conversion 
circuit 

CH3

1 ㏀~1 ㏁

Motor driver etc 

7
8

1 ㏀~1 ㏁

Motor driver etc 

GND

GND

CH0

*1 

*1 

18

17
+15V 

AGND 

DC +24V

DC  0V

DC/DC 
Conversion 

circuit 
-15V 

1 
2 

D/A conversion 
circuit 

CH3

600Ω 
or less

Motor driver etc 

7

8 600Ω 
or less 

Motor driver etc

GND

GND

CH0

*1 

*1 

18

17
+18V 

AGND 

DC +24V

DC  0V

DC/DC 
Conversion 

circuit 
-12V 

XGF-DV4A/DV8A 

XGF-DC4A/DC8A 
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3.3.1 Specification of power supply 
    DC24V specification of XGP-ACF1 is as described below;  

Rated Output Voltage DC24V 

Output Current 0.6A  

Range of Output Voltage  21.6 ~ 26.4V 

Fluctuation of Output Voltage  ±10% 

 

 
  
 

3.3.2 If XGP-ACF1 power module is used 
 

 
 
 

Remark  
 

If more than 1 analog output module are used, refer to 2.2 Performance Specifications to calculate 

DC24V consumed power for the application appropriate to power capacity. 

3.3 Wiring of DC 24V 

XGP-AF1                         XGF-DV4A/DV8A/ XGF-DC4A/DC8A 
 



Chapter 3 Installation and Wiring 
 

3 - 4 

 

3.3.3 If an external power module is used 
         − If an external power supplier is used, connect Analog output module with DC+24V of the external 
           power supplier. 

− If an external power supplier is used, a noise filter is recommended for Analog output module side. 
− Refer to 3.3.1 Specification of power supply for details on power specification of DC+24V 

necessary for Analog output module. 
 

If a noise filter is not used  
 

XGF-DV4A/DV8A/DC4A/DC8A 

 

 

If a noise filter is used  
 

XGF-DV4A/DV8A/DC4A/DC8A 

 

   

Remark  

1) Wiring between noise filter and Analog output module should be separately performed from other cables. 
2) Wiring between noise filter and Analog output module should be as short as possible. 
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Chapter 4 Operation Procedures and Monitoring 

 

The processing for the operation is as shown in Fig. 4.1 

 
[Fig. 4. 1] Procedures for the operation 

4.1  Operation Procedures 

Start 

Install Analog output module the slot. 

Connect Analog output module with the external device. 

Will you specify operation 

parameters through  

[I/O Parameter Setting]? 

Specify operation parameters through  

[I/O Parameter Setting] 

YES 

Prepare PLC program 

END 

NO 
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Analog output module’s operation parameters can be specified through XG5000’s [I/O Parameters]. 

 
4.2.1 Setting items 

Analog output module is used to execute parameters setting and monitoring/test function of the 

applicable module through XG5000 menu or tool bar, or read/write the data of internal memory by 

means of the scan program. 

For the user’s convenience with Analog output module, XG5000 provides GUI (Graphical User 

Interface) for parameters setting of Analog output module. Setting is available through [I/O Parameters] 

on the XG5000 project window. 
 

 Function of [I/O Parameters] 

Item Details 

[I/O parameters] 

(1) Specify the following setting items necessary for the module operation. 
-  Channel Disable/Enable 
-  Analog output range 
-  Input data type 
-  Channel output type 

(2) The data specified by user through XG5000 will be saved on Analog output 
module when [Special Module Parameters] are downloaded. In other words, 
the point of time when [Special Module Parameters] are saved on Analog 
output module has nothing to do with PLC CPU’s status Enable or Disable.

 

4.2.2 How to use I/O parameters 
How to use [I/O parameters] will be described below as based on XGF-DV4A. Sequence of XGF-

DC4A/DC8A/DV8A to use is also as identical as specified below. 

1) Run XG5000 to create a project. (Refer to XG5000 program manual for details on how to 

create the project) 

2) Double-click [I/O Parameters] on the project window. 
 

 

4.2 Operation Parameters Setting 
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4.3.1 Setting screen of parameters 

1) Double-click I/O parameters on the project window, to the left side of the XG5000 project created. 

2) If [IO Parameters] setting window is displayed, click the module area of the applicable slot to select 

the applicable module. 

 
3) On the [I/O Parameters] Setting screen, find and click the slot of the base Analog output module is 

installed on.  

 

 

4.3 Parameters Setting  
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4) Click the arrow button on the screen above to display the screen where an applicable module can 

be selected. Search for the applicable module to select. 

 
  

5) A screen will be displayed for you to specify parameters for respective channels as shown below. 

Click a desired item to display parameters to set for respective items.  

  Double-click the applicable slot selected for parameters setting or click [Details]. 

 

   (1) Channels: Select Disable or Enable. 
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(2) Analog output range: Select the range of analog output voltage as desired. XGF-DV4A 

provides 4 voltage output ranges, and XGF-DC4A provides 2 current output ranges. 

 

(3) Input type: Select the format of input data. 4 formats are available in total. 

 

(4) CH. Output type: Select the type of output status. 4 ranges are available in total. 
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6) Specify parameters as necessary.  

After setting, click [OK]. 

 

   7) Default of parameters setting 

Parameter Setting Item Default 

Channels Enable/Disable Stop 

Analog range 1~5V/0~5V/0~10V/-10~10V (voltage type) 
4~20mA/0~20mA (current type) 

1~5V 
4~20mA 

Input type 0~16000/-8000~8000/1000-5000/0~10000%
(changed based on the output range) 0~16000 

Channel output type Prev/Min/Mid/Max  Previous 

 

8) How to select the whole channels to change parameters. 

Click and check the button in the parameters item in order to change the whole channels to identical 

setting value. And then change the parameters of an optional channel to change the parameters of 

the whole channels at a time. The Figure below shows an example that the channel is changed to 

whole channels ‘Enable’ by means of this function. 
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4.4 Monitoring /Test 
 

4.4.1 Monitoring / Test screen 
 

1) Go through [Online] -> [Connect] and [Monitor] -> [Special Module Monitoring] to start. If the 

status is not [Online], [Special Module Monitoring] menu will not be active. 

 
 

 

2) With XG5000 connected to PLC CPU (Online status), click [Monitor] -> [Special Module 

Monitoring] to display ‘Special Module List’ screen as in the figure below showing base/slot 

information in addition to special module type. The module installed on the present PLC system 

will be displayed on the list dialog box. 
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3) Select Special Module in the figure and click [Module Info.] to display the information as 

described below. 

 
 

4) After the module is selected, click [Monitor] to display the monitoring screen as shown below. 

 
 

 

 

 

 

 

Specified parameters when tested 
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5) [Start Monitoring]: Click [Start Monitoring] to display D/A output value of the presently operated 

channel. The figure is the monitoring screen displayed when the whole channels of XGF-DV4A are in 

Run mode.  

 

6) [Test]: [Test] is used to change the presently specified parameters of Analog output module. Click 

the setting value at the bottom field of the screen to change parameters.  

[Test] can be set only when CPU operation status is in [Stop].     

 

- [Setting Value Change] -> [Test] -> Change current value 

7) [Close]: [Close] is used to escape from the monitoring/test screen.  

 
4.4.2. Operation by program 

• Analog output module can be operated with Tx. (Write) instruction of PUT/PUTP and Rx. (Read) 

 instruction of GET/GETP executed from PLC CPU by means of the scan program. 

• Refer to Chapter 6 Programming for more details.  

 

Monitoring screen 

Details of channel 0 
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4. 5 Register U Devices 
 

This section describes the automatic registration function of the U device in the XG5000 

 

4.5.1 Register U devices 
Register the variables for each module referring to the special module information that is set in the 

I/O parameter. The user can modify the variables and comments. 

 

 [Procedure] 

1) Select the special module type in [I/O parameters] setting window. 

 

2) Double click ‘Variable/Comment’ from the project window. 

 

3) Select [Edit] -> [Register U Device]. 
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4) Click ‘Yes’ 

 

 

5) As shown below, the variables are registered. 

 

 

4.5.2 Save variables 
1) The contents of ‘View Variable’ can be saved as a text file. 

2) Select [Edit] -> [Export to File]. 

3) The contents of ‘View Variable’ are saved as a text file. 
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4.5.3 View variables 
 

1) The example program of XG5000 is shown below.  

 

 

2) Select [View] -> [Variables]. The devices are changed into variables. 

 

 

3) Select [View] -> [Device/Variable]. Devices and variables are both displayed. 
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4) Select [View] -> [Device/Comment]. Devices and comments are both displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Register U device function delete previous U device information and Variable/Comment is 
added to Variable/Comment list referring to the current I/O parameter.  
 

Remark 
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Chapter 5 Configuration and Function of Internal Memory 

Configuration of internal memory is as described below. 
 
5.1.1 I/O area of D/A converted data 
 

I/O area of D/A converted data is as displayed in Table 5.1 
 

[Table 5. 1] I/O area of D/A converted data  
 

Address Description Details Remarks 

Uxy.00 Module Ready / Error Area to display D/A module operation status 
(Module Ready / Error) 

Uxy.01 CH operation information Area to save operation information of respective 
channels 

Read 
available 

Uxy.02 Output setting Bit On (1) : Output Enable  
Bit Off (0) : Output Disable 

Uxy.03 CH0 digital input value 
Uxy.04 CH1 digital input value 
Uxy.05 CH2 digital input value 
Uxy.06 CH3 digital input value 
Uxy.07 CH4 digital input value*1 
Uxy.08 CH5 digital input value*1 
Uxy.09 CH6 digital input value*1 
Uxy.10 CH7 digital input value*1 

Area to specify digital data for D/A conversion 
 
(*1: Only for XGF-DV8A/DC8A) 

Read/Write 
available 

 
1) In the device assigned, x stands for the Base Number and y for the Slot Number on which 

module is installed. 
2) In order to read ‘CH1 digital output value’ of Analog output module installed on Base No.0, Slot 

No.4, it should be displayed as U04.03. 
 
 

 
 
 
 
 

 
 
 

 

5.1 Configuration of Internal Memory 
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5.1.2 Setting area of operation parameters  
 

Setting area of Analog output module’s operation parameters is as described in Table 5.2. 
 

[Table 5. 2] Setting area of operation parameters 
 

Address 
(Dec.) Description Details Remarks 

0 Specify channel to use Bit On (1): Channel Enable 
Bit Off (0): Channel Disable 

Specify output voltage range  

Bit (00): 1~5V 
Bit (01) : 0~5V 
Bit (10): 0~10V 
Bit (11) : -10~10V 1 

Specify output current range  Bit (00): 4~20mA 
Bit (01): 0~20mA 

2 Specify input type  

Bit (00): 0~16000  
Bit (01): -8000~8000 
Bit(10): 1000~5000 (1~5V) 

0~5000 (0~5V) 
0~10000 (0~10V)  
-10000~10000 (-10~10V) 

Bit(11): 0~10000 
3 Specify CH0 output type 
4 Specify CH1 output type  
5 Specify CH2 output type  
6 Specify CH3 output type  
7 Specify CH4 output type*1 
8 Specify CH5 output type*1 
9 Specify CH6 output type*1 
10 Specify CH7 output type*1 

“0”: outputs the previous value 
“1”: outputs the min. value of output range 
“2”: outputs the mid. value of output range 
“3”: outputs the max. value of output range 
 
(*1: Only for XGF-DV8A/DC8A) 

Read/Write
available 

11 CH0  setting error 
12 CH1  setting error 
13 CH2  setting error 
14 CH3  setting error 
15 CH4  setting error*1 
16 CH5  setting error*1 
17 CH6  setting error*1 
18 CH7  setting error*1 

Error code area 
 
(*1: Only for XGF-DV8A/DC8A) 

Read  
available 
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5.2 I/O area of D/A converted data 
 
 

5.2.1 Module Ready/Error (Address 0)  
 

1) Uxy.00.F : It will be ON when PLC CPU is powered or reset with D/A conversion ready to process 
 D/A conversion. 

2) Uxy.00.0 : It is a flag to display the error status of Analog output module for respective channels. 
 

 

 
 
 

 
 
 
 

 
5.2.2 Channel operation information (Address 1) 
 

1) This area is used to display the channel being used. 
 
 
 
 

 
 
 
 

5.2.3 Output setting (Address 2) 
 

1) Enable/Disable D/A output can be specified for respective channels. 
2) If the output is not specified, output of all the channels will be disabled. 
3) Enable/Disable D/A output is as specified below. 
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U Uxy.00 

Error information 
Bit ON (1): Error, Bit Off (0): Normal 

Module Ready 
Bit ON (1): Ready, Bit Off (0): Not Ready 

Run channel information 
Bit On (1): During Run, Bit Off (0): Operation Stop 

Uxy.01 

Run channel information 
Bit ON (1): Allowed, Bit Off (0): Prohibited 

Uxy.02 

B:bit 

B:bit 

B:bit 
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5.2.4 Digital input (Address 3~6) 
 

1) Digital input value can be selected and used within the range of -192~16191, -8192~8191, 
952~5047 or -120~10191 for 1~5V based on input type.  

2) If the digital input value is not specified, it will be set to 0. 
 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Channel# digital input value 
  

 

Address Details 

3 CH0 digital output value 

4 CH1 digital output value 

5 CH2 digital output value 

6 CH3 digital output value 

7 CH4 digital output value 

8 CH5 digital output value 

9 CH6 digital output value 

10 CH7 digital output value 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Uxy.03 ~ Uxy.6 

B:bit 
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5.3.1 Specifying channels to use 
 

If the channel to use is not specified, all the channels will be set to Stop. 
 

 

 
 
 

 
 

BIT Details 
0 Stop 
1 Run 

 
 
 

5.3.2 Setting Output Voltage/Current range 
 
1) The range of analog output can be specified for respective channels. 
2) If the output range is not specified, the range of all the channels will be set to 1~5V for voltage 

output, and 4~20 mA for current output. 
3) Setting of output range is as specified below. 
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BIT Details 
00 1V ~ 5V / 4 ~ 20mA 
01 0V ~ 5V / 0 ~ 20mA 
10 0V ~ 10V 
11 -10V ~ 10V 

 
 

 
 
 
 
 
 
 
 
 
 

5.3 operation parameters settings 
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5.3.3 Specifying Input data type  
 

1) Input type can be specified for respective channels. 
If input type is not specified, all the channels will be set to the range of 0~16000. 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 
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 C 
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BIT Details 
00 0 ~ 16000 
01 -8000 ~ 8000 
10 Precise Value 
11 0 ~ 10000 

 
This area is used to specify D/A input type for respective channels. 
The precise value has the digital input ranges as follows; 

 
Analog output 

Digital input 1 ~ 5V 0 ~ 5V 0 ~ 10V -10 ~ 10V 

Precise Value 1000~5000 0~5000 0 ~ 10000 -10000 ~  
    10000 

 
         Analog output 
Digital input 4 ~ 20mA 0 ~ 20mA 

Precise Value 4000 ~ 20000 0 ~ 20000 

 
 

5.3.4 Setting Output data type 
 
Based on setting value, the output status is as follows; Setting range is 0~3. 

 
 

 

 
 
 
 

Setting value Details 
0 Keeps the previous value as it is 
1 Outputs the minimum value of output range  
2 Outputs the middle value of output range 
3 Outputs the maximum value of output range 

 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Channel# Setting value Address “3~10”

B:bit 

Address “2” 
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5.3.5 Error code 
 

Error codes detected from Analog output module will be saved. 
 

 

 
 

 
 

Error Code 
(Dec) Details LED status 

10 Module error (Reset Check Error) 
11 Module error (Ram Check Error) 
12 Module error (Register Check Error) 
13 Module error (EEPROM Check Error) 
21 Module error (D/A Conversion Error) 

Blinks every 
0.2 sec. 

31# Note) Current module’s parameters setting error 
32# Note) Parameters setting error when setting current module’s Offset/Gain 

40# Note) 
Setting error of current module’s digital input range  
(If input value is set less than -192, or greater than 16191) 
The range changes based on input type 

41# Note) 
Setting error of voltage module’s digital input range 
(If input value is set less than -192, or greater than 16191) 
 The range changes based on input type 

50# Note) Offset/Gain setting error in current module of 4~20 mA  
(If Offset value is set greater than or equal to Gain value) 

51# Note) Offset/Gain setting error in current module of 0~20 mA 
(If Offset value is set greater than or equal to Gain value) 

52# Note) Offset/Gain setting error in voltage module of 1~5V 
(If Offset value is set greater than or equal to Gain value) 

53# Note) Offset/Gain setting error in voltage module of 0~5V 
(If Offset value is set greater than or equal to Gain value) 

54# Note) Offset/Gain setting error in voltage module of 0~10V  
(If Offset value is set greater than or equal to Gain value) 

55# Note) Offset/Gain setting error in voltage module of -10~10V (#: channel) 
(If Offset value is set greater than or equal to Gain value) 

Blinks every 
1 sec. 

 
Note) # (0~3) stands for the channel with error found.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — —
-

—
— — — Channel# Error code Address 11~14”

Refer to the table below for detailed error codes
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Chapter 6 Programming 
 

6.1 Internal Memory Read/Write 
 

6.1.1 Read of internal memory (GET, GETP instruction) 
  
 
 
 
 
 

< Difference between GET instruction and GETP instruction > 
 
        GET  : always executed with execution condition On      (                  ) 

        GETP : executed with execution condition of operation start (                  ) 

 
 If Analog output module is installed on base No.0 and slot No.3, and internal memory 
 address No.0 & 1’s data in Analog output module is read to D16 and D17 of CPU module. 

  

Address D area of CPU module  Internal memory of Analog 
output module Address

D00015     

D00016 Run channel setting  Run channel setting 0 

D00017 Range of output voltage/current  Range of output voltage/current 1 

D00018    2 

D00019    3 
 

 
 
 
 

 
 

Type Description Area available 

n1 Slot No. the special module is installed on Integer 

n2 Start address of special module’s internal memory to read data Integer 

D Device’s start address with saved data to read M, P, K, L, T, C, D, #D 

n3 Number of words data to read Integer 

 

GET instruction 
Execution condition 

  GET    n1   n2    D    n3 

Type 

Example 
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6.1.2 Write of internal memory (PUT, PUTP instruction) 

 
 
 
 
 
 
 
                                                                                                             

< Difference between PUT instruction and PUTP instruction > 
 
        PUT  : always executed with execution condition On      (                  ) 

        PUTP : executed with execution condition of operation start (                  ) 

 
If Analog output module is installed on Base No.0 and Slot No.6, and CPU module’s data of 
D16~D17 is written on internal memory addresses 0~1 of Analog output module, 
 

Addres
s D area of CPU module  Internal memory of Analog 

output module 
Addres

s 

D00015     

D00016 Data 1  Run channel setting 0 

D00017 Data 2  Range of output voltage/current 1 

D00018    2 

D00019    3 
 

 
 

 

 
 
 

Type Description Area available 

n1 Slot No. the special module is installed on Integer 

n2 Start address of special module’s internal memory to write data. Integer 

S Device’s start address or integer with saved data to write. M, P, K, L, T, C, D, #D, integer

n3 Number of words data to write Integer 

 

PUT instruction 
Execution condition 

  PUT     n1    n2     S     n3 

Type 

Example 
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6.2 Basic Program 
 
  1) How to specify Run condition details of Analog output module’s internal memory will be described. 
  2) Analog output module is as installed on slot 1. 
  3) I/O assigned points of Analog output module is 16 points. 
 

System Configuration 
 

 
XGP-APF1 
 

 
XGK-CPU
H 

 
 

XGF-DC4
A 
 

RUN 

  

 
 
 
 
 
 
 
 
 
 
 

     

 
 

 
6.2.1 XGF-DC4A  
 

1) Program example through [I/O Parameters] setting 
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2) Program example with PUT/GET instruction used 

 
 
 

All CH output enable 

CH0 digital value Write 

CH1 digital value Write 

CH2 digital value Write 

CH3 digital value Write 

 
CH Run information 

Digital value to output Module Ready 

 

All CH output enable 

CH0 digital value Write 

CH1 digital value Write 

CH2 digital value Write 

CH3 digital value Write 

Used CH(CH0.1.2.3) 
Output range(4~20mA) 

Data type (0~16000) 

CH output status setting 
 
0,1,2,3:Output previous 
value 

Module Ready 

CH Run 
information 

Slot No. 
Internal memory address 

Setting data

The number of data to write
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6.3 Application Program 

 
  6.3.1 Inverter speed control 
 

1) System Configuration 
 

 
 
2) Details of initial setting 
 

No Parameters Setting Details Internal Memory Address
1 Channels CH 0 ~ 3 0 
2 Output voltage range 0 ~ 10V 1 
3 Data type 0 ~ 16,000 2 
4 Channel Output type Previous value 3,4,5,6 

 
3) Description of program 
 
 (1) At the same time Module Ready Contact is On, output of all the channels will be set to 

Allowed. 
 (2) If P0001 is On, 0V will be output. 
 (3) If P0002 is Off and P0002 is On, 2.5V will be output. 
 (4) If P0003 is Off and P0003 is On, 5V will be output. 
(5) If P0004 is Off and P0004 is On, 7.5V will be output. 
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4) Program 

 
(1) Program example through I/O Parameters Setting. 

 

 
 

 
 
 

 
(2) Program 

 
 

 
 

All CH output allowed 

If P1 is On, 0V is output 

If P2 is On, 2.5V is output 

If P3 is On, 5V is output 

If P4 is On, 7.5V is output 

Module Ready 

Execution 
contact 
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(3) Program example with PUT/GET instruction used 
 

 
 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Module Ready Slot No. 

Internal memory 
address 

Setting data 

Output allowed

CH Run 
(0~3) 

Output range
(0~10V) 

Data type 
(0~16,000) 
CH0 output status
(Previous value)

CH1 output status
(Previous value)

CH2 output status
(Previous value)

CH0 output status
(Previous value)

CH0 output value
(2.5V output) 
CH1 output value
(5V output) 

CH2 output value
(7.5V output) 

CH3 output value
(10V output) 

The number of data to 
write 
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6.3.2 BCD output of error code 
 

1) System Configuration 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 

2) Details of initial setting 
 

(1) Used CH: CH 0 
(2) Analog output current range: DC 4 ~ 20 mA 
(3) Digital input data range: 0 ~ 16000 

 
3) Description of program 
 

(1) If P00000 is On, D/A conversion will be initially specified. 
(2) If P00001 is On, D/A converted value and error code will be saved respectively on D00000 

and D00001. 
(3) If P00002 is On, applicable error code will be output to digital BCD display. (P00040 ~ 

P0004F) 
 

4) Program  
 

(1) Program example through [I/O Parameter] setting 
 

       
 
 
 
 
 

XGP- 
ACF2 

XGK- 
CPUS 

XGI- 
D24A 

XGQ- 
RY2A 

XGF- 
DC4A 

Digital BCD display 
(error display) 

XGQ- 
RY2A 
 

Initial value setting 

Error code output to BCD 

P0000 

P0001 

P0002 

D/A converted value & error
code value saved 

Execution contact 
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(2) Program example with PUT/GET instruction used 
 
 

 

 
 
 
 
 
 
 
  

Used CH setting 
(CH 0)

CH 0’s 12mA output 

Save error code on D1
 
Convert D1 saved data 
to BCD to output to 
P040 

Conversion setting of 
error code to BCD 

Module READY Execution contact 

Conversion setting of 
error code to BCD 

Module READY 

CH 0’s 12mA output

Save error code on D1
 
Convert D1 saved data 
to BCD to output to 
P040 

Used CH setting
(CH 0)

Output range 
(4~20mA) 

Data type 
(0~16,000) 

CH0 output status
(Previous value)

D/A output allowed

D/A output allowed 

P 
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Chapter 7 Configuration and Function of Global variable (For XGI/XGR) 
 

7.1 Global Variable (Data area) 
 

7.1.1 D/A conversion data I/O area configuration 
Indicates D/A conversion data I/O area at table 7.1 

Global variable Memory 
allocation Description Read/Write

_xxyy_CH0_ERR  %UXxx.yy.0 CH 0 error flag  Read 
_xxyy_CH1_ERR  %UXxx.yy.1 CH 1 error flag  Read 
_xxyy_CH2_ERR  %UXxx.yy.2 CH 2 error flag Read 
_xxyy_CH3_ERR  %UXxx.yy.3 CH 3 error flag Read 
_xxyy_CH4_ERR  %UXxx.yy.4 CH 4 error flag Read 
_xxyy_CH5_ERR  %UXxx.yy.5 CH 5 error flag Read 
_xxyy_CH6_ERR  %UXxx.yy.6 CH 6 error flag Read 
_xxyy_CH7_ERR  %UXxx.yy.7 CH 7 error flag Read 
_xxyy_RDY %UXxx.yy.15 Module ready flag Read 

_xxyy_CH0_OUTEN %UXxx.yy.32 
CH 0 output status setting bit 

On(1) : enable output, Off(0) : disable output 
Read/Write

_xxyy_CH0_OUTEN %UXxx.yy.33 
CH 1 output status setting bit 

On(1) : enable output, Off(0) : disable output 
Read/Write

_xxyy_CH0_OUTEN %UXxx.yy.34 
CH 2 output status setting bit 

On(1) : enable output, Off(0) : disable output 
Read/Write

_xxyy_CH0_OUTEN %UXxx.yy.35 
CH 3 output status setting bit 

On(1) : enable output, Off(0) : disable output 
Read/Write

_xxyy_CH0_OUTEN %UXxx.yy.36 
CH 4 output status setting bit 

On(1) : enable output, Off(0) : disable output 
Read/Write

_xxyy_CH0_OUTEN %UXxx.yy.37 
CH 5 output status setting bit 

On(1) : enable output, Off(0) : disable output 
Read/Write

_xxyy_CH0_OUTEN %UXxx.yy.38 
CH 6 output status setting bit 

On(1) : enable output, Off(0) : disable output 
Read/Write

_xxyy_CH0_OUTEN %UXxx.yy.39 
CH 7 output status setting bit 

On(1) : enable output, Off(0) : disable output 
Read/Write

_xxyy_CH0_DATA %UWxx.yy.3 CH 0 digital input value 
_xxyy_CH1_DATA %UWxx.yy.4 CH 1 digital input value 
_xxyy_CH2_DATA %UWxx.yy.5 CH 2 digital input value 
_xxyy_CH3_DATA %UWxx.yy.6 CH 3 digital input value 
_xxyy_CH4_DATA %UWxx.yy.7 CH 4 digital input value 
_xxyy_CH5_DATA %UWxx.yy.8 CH 5 digital input value 
_xxyy_CH6_DATA %UWxx.yy.9 CH 6 digital input value 
_xxyy_CH7_DATA %UWxx.yy.10 CH 7 digital input value 

Read/Write

[Table 7. 1] A/D conversion data IO area 
         
 

※ At the device allocation, xx means base number and yy means slot number where module is installed. 
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7.1.2 How to use global variable 

- In order to register global variable, there are two method, auto registration after setting I/O parameter       

 at project window and batch registration after setting I/O parameter 

 

(1) I/O parameter registration 

- Registers module you want to use at I/O parameter 

 (a) Double-click I/O parameter of project window 

  
 (b) Select XGF-DV8A module at I/O parameter window 

 

(c) Set parameter by pressing [Details] and select [OK] 
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(d) Select [Yes] 

      - Global variable of module set in I/O parameter is registered automatically.r 

 

 

(e) Check global variable auto registration 

- Double-click Global/Direct Variable of project window  
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(2) Global variable registration 

    - Registers global variable set in I/O parameter 

    (a) Double-click Global/Direct Variable of project window  

   

 

     (b) Select [Register Special Module Variables] at menu [Edit] 
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(3) Local variable registration 
- Registers variable among registered global variable you want to use as local variable. 
 

(a) Double-click local variable to use in the following scan program. 

 
  

(b) Click right button of mouse in the right local variable window and select “Add EXTERNAL variable”.  

 

Double-click 
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(c) Select local variable to add at Global View on “Add External Variable” window (“All” or “Base, slot”).  
 

  -View All 

 

- View by base, slot 

 

 

(d) The following is example selecting digital output value (_0001_CH0_DATA) of “Base00, Slot01”. 
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(4) How to use local variable on program 

- It describes the added global variable at local program. 
- The following is example getting the conversion value of CH0 of Analog input module to %MW0. 

(a) In case of inputting constant value (4000) into CH 0 (_0001_CH1_CH0_DATA) by using the following MOVE function, double 

click variable window part behind OUT, then “Select Variable” window shows up.  

 

 

 

 

 

 

(b) Select global variable at variable type at Select Variable window. And select relevant base (0 base, 1 slot) at global variable 

list item.  

  

(c) Double-click or select _0001_CH0_DATA corresponding to CH0 D/A conversion data and click [OK]. 

  
(d) The following figure is result adding global variable corresponding to CH0 D/A conversion value.  

 

Double-click 
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7.2.1 PUT/GET Function Block use area (Parameter area) 

It indicates operation parameter setting area of Analog output module at table 7.2. 

Global variable Description Type Read/Write Instruction 

_Fxxyy_CH_EN Channel enable/disable setting WORD Read/Write PUT 
_Fxxyy_OUT_RANGE Output voltage/current range setting UINT Read/Write PUT 
_Fxxyy_DATA_TYPE Input data type setting UINT Read/Write PUT 
_Fxxyy_CH0_STAT CH 0 output status setting value UINT
_Fxxyy_CH1_STAT CH 1 output status setting value UINT
_Fxxyy_CH2_STAT CH 2 output status setting value UINT
_Fxxyy_CH3_STAT CH 3 output status setting value UINT
_Fxxyy_CH4_STAT CH 4 output status setting value UINT
_Fxxyy_CH5_STAT CH 5 output status setting value UINT
_Fxxyy_CH6_STAT CH 6 output status setting value UINT
_Fxxyy_CH7_STAT CH 7 output status setting value UINT

Read/Write PUT/GET 

_Fxxyy_CH0_ERR CH 0 error code UINT
_Fxxyy_CH1_ERR CH 1 error code UINT
_Fxxyy_CH2_ERR CH 2 error code UINT
_Fxxyy_CH3_ERR CH 3 error code UINT
_Fxxyy_CH4_ERR CH 4 error code UINT
_Fxxyy_CH5_ERR CH 5 error code UINT
_Fxxyy_CH6_ERR CH 6 error code UINT
_Fxxyy_CH7_ERR CH 7 error code UINT

Read GET 

 
[Table 7. 2] Operation parameter setting area 

※ At the device allocation, xx means base number and yy means slot number where module is installed 

7.2 PUT/GET Function Block use area (Parameter area) 
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7.2.2 PUT/GET instruction 
 
(1)PUT instruction 

 

    PUT     

Writing data to special module 
 

 

Function Block Description 

 

UINT

PUT

DONE

BASE

SLOT

MADDR

STAT

BOOL

USINT

UINT

USINT

*ANY DATA

REQBOOL

 

 

Input 

REQ : execute function when 1 
 BASE  : set base position 
 SLOT  : set slot position 
 MADDR : module address 
 DATA : data to save module 
 
Output  
DONE  : Output 1 when normal 
 STAT  : Error information 
 

 

  *ANY: WORD, DWORD, INT, USINT, DINT, UDINT type available among ANY type 
 

  ■ Function  
Writes data to the designated special module 
 

Function Block Input(ANY) type Description 
PUT_WORD WORD Save WRD data into the designated module address (MADDR). 

PUT_DWORD DWORD 
Save DWORD data into the designated module address 
(MADDR). 

PUT_INT INT Save INT data into the designated module address (MADDR). 
PUT_UINT UINT Save UNIT data into the designated module address (MADDR). 
PUT_DINT DINT Save DINT data into the designated module address (MADDR). 

PUT_UDINT UDINT Save UDINT data into the designated module address (MADDR). 
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(2) GET instruction 
 

    GET     

Reading from special module data  
 

 

Function block Description 

 

UINT

GET

DONE

BASE

SLOT

MADDR

STAT

BOOL

USINT

UINT

USINT *ANYDATA

REQBOOL

 

 

Input 

 REQ : execute function when 1 
 BASE  : set base position 
 SLOT  : set slot position 
 MADDR : module address 

512(0x200) ~ 1023(0x3FF) 
 
Output 
DONE  : output 1 when normal 
 STAT  : Error information 
 DATA : data to read from module 
 

 

 *ANY: WORD, DWORD, INT, UINT, DINT, UDINT type available among ANY type 
 

■ Function 
Reads data from designated special module 

 

Function Block Output(ANY) type Description 

GET_WORD WORD 
Read data as much as WORD from the designated module address 
(MADDR). 

GET_DWORD DWORD 
Read data as much as DWORD from the designated module 
address (MADDR). 

GET_INT INT 
Read data as much as INT from the designated Module address 
(MADDR). 

GET_UINT UINT 
Read data as much as UNIT from the designated module address 
(MADDR). 

GET_DINT DINT 
Read data as much as DINT from the designated module address 
(MADDR). 

GET_UDINT UDINT 
Read data as much as UDINT from the designated module address  
(MADDR). 
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7.2.3 Example using PUT/GET instruction  

(1) Enable channel 
(a) You can enable/disable D/A conversion per channel 
(b) Disable channel not using to reduce the conversion cycle per channel 
(c) When channel is not designated, all channels are set as not used 
(d) Enable/disable of A/D conversion is as follows  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

- - - - - - - - 

C 

H 

7 

C 

H 

6 

C

H

5

C

H

4

C

H

3

C

H

2

C

H

1 

C

H

0

16#0003 : 0000 0000 0000 1111 

 

                         CH3, CH2, CH1, CH0 

Bit Description 

0 Stop 

1 Run 

 

 
(e) The value in B8~B15 is ignored. 
(f) The right figure is example enabling CH0~CH3 of D/A module equipped at slot 0. 
 

 

(2)Output voltage/current range setting 
(a) You can set output voltage/current range per channel 
(b) When analog output range is not set, all channels are set as 1 ~ 5V  
(c) Setting of analog output voltage/current range is as follows. 

1) XGF-DV4A 

- The following is example setting CH 0~ CH1 as 1~5V and CH2~ Ch3 as 0~10V.  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

CH7 CH6 CH5 CH4 CH3 CH2 CH1 CH0 

16#00A0 : 0000 0000 1010 0000 

 

   CH7, CH6,  CH5,   CH4,  CH3,   CH2,  CH1,   CH0 

Bit Description 
00 1 V ~ 5 V 
01 0 V ~ 5 V 
10 0 V ~ 10 V 
11 -10 V ~ 10 V 

 

 

 

Set channel 
to use 

Input range  

setting 
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2) XGF-DC4A 

- The following is example setting CH 0~ CH1 as 4~20mA and CH2~ Ch3 as 0~20mA.   

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

CH7 CH6 CH5 CH4 CH3 CH2 CH1 CH0 

16#00A0 : 0000 0000 1010 0000 

 

   CH7,  CH6, CH5,   CH4,  CH3,   CH2,  CH1,   CH0 

Bit Description 
00 4 mA ~ 20 mA 
01 0 mA ~ 20 mA 

 

 
(3) Input type setting 

 
(a) Digital input type can be set per channel.  
(b) When input type is not set, all channels are set as 0 ~ 16000.  
(c) Setting of digital input type is as follows 
(4) In the following figure, CH0~CH1 is set as -8000~8000, CH2~CH3 is set as 0~16000. 
  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

CH3 CH2  CH1 CH0 

16#2012 : 0010 0000 0001 0010 
             CH3,  CH2,  CH1,  CH0 

Bit Description 
00 0~ 16000 
01 -8000~8000 
10 Precise Value 
11 0~10000 

 

 
Precise value has the following digital input type about analog output range 
1) XGF-DV4A 

Analog output 
 
Digital input 

0 ~ 5V 1 ~ 5V 0 ~ 10V -10 ~ 10V 

 Precise Value 0 ~ 5000 1000 ~ 5000 0 ~ 10000 -10000 ~ 10000 
2) XGF-DC4A 

Analog output 
 
Digital input 

4 ~ 20 ㎃ 0 ~ 20 ㎃ 

 Precise Value 4000 ~ 20000 0 ~ 20000 
 

Input range 
setting 
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(4) Output status setting 
(1) Output status according to setting value is as follows. (Setting range is 0~3.) 
(2) The following figure is example setting the output status as Former value.  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

Setting value 

    

Setting value Description 
0 Holds Former value in case of error 
1 Outputs Min. value of output range in case of error
2 Outputs Mid. value of output range in case of error
3 Outputs Max. value of output range in case of error

 

 

(5) Error code 
(a) Saves error code detected at Analog output module 
(b) Error type and contents are as follows 
(c) The following figure is program example reading error code 
  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

— — — — — — — — CH# Error code 

Error code 
(Decimal) 

Description LED status 

10 Module error (Reset Check Error) 
11 Module error (Ram Check Error) 
12 Module error (Register Check Error) 
13 Module error (EEPROM Check Error) 
21 Module error (D/A Conversion Error) 

0.2s flickering 

31# note) Parameter setting error or current module 
32# note) Parameter setting error when setting offset/gain of current module 

40# note) 

Digital input value of current module is out of range. 
(When input type is 0~16000 and the digital input value is smaller than -
192 or larger than 16191.)  
Effective range varies according to input type. 

41# note) 

Digital input value of voltage module is out of range. 
(When input type is 0~16000 and the digital input value is smaller than -
192 or larger than 16191.)  
Effective range varies according to input type. 

50# note) Offset/gain setting error at 4~20mA of current module 
(Offset is same as or larger than gain) 

51# note) Offset/gain setting error at 0~20mA of current module 
(Offset is same as or larger than gain) 

52# note) Offset/gain setting error at 1~5V of voltage module 
(Offset is same as or larger than gain) 

53# note) Offset/gain setting error at 0~5V of voltage module 
(Offset is same as or larger than gain)  

54# note) Offset/gain setting error at 0~10V of voltage module 
(Offset is same as or larger than gain) 

55# note) Offset/gain setting error at -10~10V of voltage module 
(Offset is same as or larger than gain) 

1s flickering 

 

 

※ At error code, # indicates channel where error occurs 
 (d) In case two error codes occurs, module saves first occurred error code and later occurred error code is not saved 

 

Error code 
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Chapter 8 Programming (For XGI/XGR) 
 

8.1 Basic Program  
 

- How to specify operating condition in analog output module’s internal memory will be described. 
- Analog input module is installed on Slot 1. 
- I/O assigned points of analog output module is 16 points  
 
System configuration 

 
8.1.1 XGF-DC4A 
(1) Program example using [I/O parameters] setting  

        

 

Note  

For XGR series, you can’t install the special card at main base. Available base for special card is 1~31. Program example is written based on 

XGI CPU. 
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Enable outputs of all channels 

Writing CH0 digital value (8㎃) 

Writing CH1 digital value (12㎃) 

Writing CH2 digital value (16㎃) 

Writing CH3 digital value (20㎃) 

Module Ready 

CH0 operating 

CH1 operating 

CH2 operating 

CH3 operating 
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(2) Program example using PUT/GET instruction  

 

CH 

(0.1.2.3 

operating) 

Output 

range 

(4~20mA

Data type 

(0~16000) 

CH0  

Output status 

: Former value 

Base no. 

Internal memory  

symbolic variable 
Setting data 

Module Ready 

Slot no. 

CH1  

Output status 

: Min. value 

CH2  

Output status 

: Mid. value 

CH3 

Output status 

: Max. value 

Writing CH0 digital value (8㎃) 

Writing CH1 digital value (12㎃) 

Writing CH2 digital value (16㎃) 

CH0 operating 

CH1 operating 

CH3 operating 

CH2 operating 

Writing CH3 digital value (20㎃) 
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8.2 Application Program  
 

8.2.1 Inverter Speed Control 
 

(1) System configuration 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2) Initial setting 
No Parameter Contents Internal memory address 
1 CH to use CH0 ~ CH3  
2 Output voltage range 0 ~ 10V  
3 Data type 0 ~ 16000  
4 CH output status  Former/Min/Mid/Max  

 
(3) Program description 

(a) When module ready contact is on, enables output of all channels. 
(b) If CH 0 operating flag (_0001_CH0_ACT) is on, outputs 0V. 
(c) If CH 1 operating flag (_0001_CH1_ACT) is on, outputs 2.5V. 
(d) If CH 2 operating flag (_0001_CH2_ACT) is on, outputs 5.0V. 
(e) If CH 3 operating flag (_0001_CH3_ACT) is on, outputs 7.5V. 

 

 

 

AC220V 3-phase 

Inverter 

Induction motor 
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(4) Program  
(a) Program example using “I/O Parameter” setting 

 

 

 
. Program 

 

Module ready 

Enable output of all channels 

CH0 output value (0V output) 

CH1 output value (2.5V output) 

 

CH2 output value (5V output 

 

CH3 output value (7.5V output) 

 

CH 0 
operating 

CH 1 
operating 

CH 3 
operating 
 

CH 2 
operating 
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(b) Program example using PUT/GET 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enable output of all channels 

CH0 output value (0V output) 

 

CH1 output value (2.5V output) 

 

CH2 output value (5V output) 

 

CH3 output value (7.5V output) 

  

 

Enable output of all channels 

 

Module Ready 
Base no. Slot no. 

Setting data 

CH 

(0.1.2.3 

operating) 

Output 

range 

(0~10V) 

Data type 

(0~16000) 

Internal memory  

symbolic variable 

CH0  

Output status 

: Former value 

CH1  

Output status 

: Min. value 

CH2  

Output status 

: Mid. value 

CH3 

Output status 

: Max. value 

CH0 operating 

CH1 operating 

CH2 operating 

CH3 operating 
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8.2.2 Program to output error codes of analog input module to BCD display 
(1) System configuration  

 

 

 

 

 

 

 

 

 

(2) Details of initial setting  
(a) CH to use: CH 0 
(b) Analog output current range: DC 4 ~ 20 mA  
(c) Digital input data range: 0 ~ 16000 
 

(3) Program description  
(a) If %IX0.0.1 is on, A/D converted value and error code will be saved respectively on %MW0 and %MW1. 
(b) If %IX0.0.2 is on, applicable error code will be output to digital BCD display (%QW0.3.0). 
 

(4) Program   
(a) Program example using [I/O parameters] setting 

 
 

XGP- 

ACF2 

XGK- 

CPUU 

XGI- 

D24A 

XGQ- 

RY2A 

XGF- 

DC4A

Digital BCD display 
(error display) 

XGQ- 

RY2A

 

Outputs error code to BCD 

%IX0.0.1 

%IX0.0.2 

Saves A/D converted 
value & error code 
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. Program 

 

   
 

 

 

 

 

 

 

Module ready 
CH0 output value (12mA output) 

Saves error code at %MW1 

Converts the data in %MW1 into BCD  
and saves it %QW0.3.0 Outputs error code to BCD 

Saves D/A conversion 
value and error code 

CH0 operating 
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(b) Program example using PUT/GET  
 

  

 

 

 

 

 

Module ready 

Enables output 

CH 

(0.1.2.3 

operating) 

Data type 

(0~16000) 

CH0  

Output status 

:Former value 

Output range  

(4~20mA) 

CH0 output value (12mA output) 

Saves error code at %MW1 

Converts the data in %MW1 into  
BCD and saves it %QW0.3.0 

CH0  

Operating 

Outputs error code to BCD 

Saves D/A conversion 
value and error code 
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Chapter 9 Troubleshooting 
   9.1 Error codes 
 

Details and diagnosis of errors which occur while Analog output module is used will be described. 

Error Code 

(Dec) 
Description  

LED 

status 

10 Module error (Reset Check Error) 

11 Module error (RAM Check Error) 

12 Module error (Register Check Error) 

13 Module error (EEPROM Check Error) 

21 Module error (D/A Conversion Error) 

Blinks 

every 0.2 

sec. 

31#note) Parameters setting error of current module 

32#note) Parameters setting error of current module when setting Offset/Gain. 

40#note) 
Setting error of current module’s digital input range (If input value is set less 
than -192 or greater than 16191). The range changes based on input data type. 

41# note) 
Setting error of voltage module’s digital input range (If input value is set less 
than -192 or greater than 16191). The range changes based on input data type. 

50# note) 
Offset/Gain setting error in current module of 4~20㎃  
(Offset value is set greater than or equal to Gain value) 

51# note) 
Offset/Gain setting error in current module of 0~20㎃ 
(Offset value is set greater than or equal to Gain value) 

52# note) 
Offset/Gain setting error in voltage module of 1~5V  
(Offset value is set greater than or equal to Gain value) 

53# note) 
Offset/Gain setting error in voltage module of 0~5V  
(Offset value is set greater than or equal to Gain value) 

54# note) 
Offset/Gain setting error in voltage module of 0~10V  
(Offset value is set greater than or equal to Gain value) 

55# note) 
Offset/Gain setting error in voltage module of -10~10V  
(Offset value is set greater than or equal to Gain value) 

Blinks 

every 1 

sec. 

 

Remark  
(1) # of the error code stands for the channel with error found. 

(2) If 2 or more errors occur, the module will not save other error codes than the first error code found. 
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1) If errors occur  

Error Code Module Ready Error Bit Status Error Code LED 

10, 11, 12, 13, 21 Deleted (OFF) 
Set all the 

channels 

Displayed on 

system area 

Blinks every 0.2 

sec. 

31#, 40#, 41# Kept 
Set applicable 

channel only 

Displayed on 

system area 

Blinks every 1 

sec 

32#, 50#, 51#, 

52#, 53#, 54#, 

55# 

Kept - 
Offset/Gain 

error code area 

Blinks every 1 

sec 

   

2) If errors deleted  

Error Code Module Ready Error Bit Status Error Code LED 

10, 11, 12, 13, 21 Power On/Off - - - 

31#, 40#, 41# Kept Clear Clear On 

32#, 50#, 51#, 

52#, 53#, 54#, 

55# 

Kept - Clear On 
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9.2 Troubleshooting 
 

     9.2.1 RUN LED blinks 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.2.2 RUN LED is Off 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

RUN LED is Off. 

Analog output module is installed on the base 
correctly 

Correctly install Analog output module on the base. 

Contact the nearest agency or Customer service 

center. 

Normally operated if Analog output module with error 
is changed to another module 

Error due to other module than Analog output 
module. Refer to CPU manual for more details.

No 

Yes 

Yes 

No 

RUN LED blinks. 

RUN LED blinks every 0.2 sec. 

RUN LED blinks every 1 sec. 

Go to 9.2.7 

Contact the nearest agency or Customer service 

center.

Contact the nearest agency or Customer service 

center. 

Yes 

No 

Yes 

No 

XG5000 can be connected with. 

  Check error code. 
Yes 

No 
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9.2.3 D/A Output Value hunted too much 

 

N

D/A output value is hunted too much. 

Wiring between Analog output module and 
external device is correct. 

External power (DC 24V) is supplied. 

Correct the wiring with the external device. 

Connect to DC 24V. 

Supply sufficient DC 24V current for Analog output 
module. 

Capacity of DC 24V power supply is sufficient.

D/A output value is hunted too much. 

Go to 9.2.7  

No 

Yes 

No 

Yes 

No 

Yes 
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9.2.4 Relationship discordant between Digital Input Value & Analog Output Value 
 

 

 

Relationship between digital input value and 
analog output value is not discordant. 

Wiring between Analog output module and 
external device is correct? 

Used channel is set correctly? 

Refer to 3.2 to correct wiring with the external device 

Specify the correct channel. 

Go to 9.2.7. 

Data type is specified correctly? 

Offset/Gain is specified correctly? 

Specify the correct data type 

Contact the nearest agency or Customer Service Center.

No 

Yes 

No 

Yes 

No 

Yes 

No 

Yes 
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      9.2.5 D/A Output Value always exceeds the value specified 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D/A output value always exceeds the value 
specified 

External power is normally supplied 

Offset/Gain is specified correctly. 

Supply external power properly. 

Contact the nearest agency or Service center 

Go to 9.2.7 

Wiring between Analog output module and 
external device is correct. 

D/A output value exceeds setting range. 

 Refer to 3.2 to correct wiring with the external device

Specify D/A input value range correctly. 

No 

Yes 

No 

Yes 

No 

Yes 

No 

Yes 
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9.2.6 Analog Output Value does not changed according to the change of Digital Input Value 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

      9.2.7 Hardware error of Analog output module 
 
 
 
 

 It is Analog output module’s Hardware error. 

 Contact the nearest Customer Service Center. 

Analog output value does not changed 
accordingly to the D/A input value converted. 

Applicable channel is specified correctly? 

Offset/Gain is specified correctly? 

Specify the applicable channel correctly. 

Contact the nearest agency or Service center. 

Go to 9.2.7. 

Wiring with external device is correct? 
 

Correct wiring with the external device. 

No 

Yes 

No 

Yes 

No 

Yes 
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     9.2.8 Status check of Analog output module through XG5000 System Monitoring 
Module type, module information, O/S version and module status of Analog output module can be 

checked through XG5000 system monitoring function. 

1) Execution sequence 

Two routes are available for the execution. 

(1) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button 

to display [Module Information]. 

(2) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

2) Module Information 

(1) Module type: shows the information of the module presently installed. 

(2) Module information: shows the O/S version information of Analog output module. 

(3) O/S version: shows the O/S prepared date of Analog output module. 

(4) Module status: shows the present error code.  

3) System Monitor 
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4) Monitor through program 
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Terms and abbreviation used in this user’s manual and the analog module in general are as described below. 

 

■A/D converter: converts analog to digital value proportionately to the size of analog input signal. 

   

■Analog input module: as a module with the circuit to convert analog voltage/current input signalal to digital 

value, it has resolution of 14 and 16 bits according to converters. 

 

■Channel: related with the terminal of analog I/O module and connected to various voltage/current I/O 

devices respectively, with applicable data and diagnosis function as well. 

 

■Conversion time: time necessary for analog input module to sample and convert the analog signal for the 

processor inside the module to get digital-converted value input. On the other hand, it is time necessary for 

analog output module to convert the digital value output from the processor inside the module to analog 

output signal so to transmit to the output channel. 

  

■D/A converter: related with the output module, it is used to make continuous size of analog voltage and 

current signal proportionately to the digital value.   

 

■Full scale: defined as the size of voltage/current where the normal operation is executed.   

 

■Full scale error: displayed with graph difference between agreeable analog-converted value and actual 

analog-converted value. 

   

■Full scale range: displayed with difference between the maximum and the minimum of the analog input. 

 

■LSB (Least Signalificant Bit): displays the minimum value of the bit unit. 

Appendix 1 Terminology 
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■Linearity error: analog I/O is related between continuous voltage/current value and digital value, whose 

agreeable I/O value is defined as a line within a distance of the minimum 1LSB of voltage/current. I/O 

linearity error is regarded as the declination between the agreeable-converted value and the actual-

converted value on the graph. 

 

 

 

 

 

 

 

 

 

■Multiplexer: a switching circuit where many signals share one A/D converter or D/A converter. 

 

■Analog output module: a module with output circuit to convert analog DC voltage or current signal 

proportionate to digital value delivered to the module from the processor. 

 

■Resolution: the minimum value recognizable by a measuring instrument, which is usually displayed in the 

engineering unit (1mv) or the number of bits. In other words, 16383 types of output are available for 14 bits. 

 

■Filter: used to reduce the change of the digital-converted output value by sudden change of the external 

noise or input for the analog circuit, through two methods of Software and Hardware filters. 

 

■Accuracy: displayed with the maximum declination between agreeable value and output voltage or current 

for the whole range of output. On the other hand, it is displayed with the maximum declination between 

agreeable value and digital-converted input signal value for the whole range of input. Generally, percentage 

will be displayed for the full scale. 

Gain, Offset and Linearity error are all included in the error type available. 

 

■Output accuracy: displayed with the difference between the actual analog output voltage/current value and 

the agreeable-converted value on the conversion graph for the full scale, with Offset, Gain and Drift error 

factors included as well as normal temperature (25℃) and available temperature range displayed 

respectively. 

Agreeable-converted value

Actual-converted value 



Appendix 2 Dimensions 
 

Appendix 2-1 

 
 

 

1) Dimensions of XGF-DV4A/DC4A 

 

(Unit : mm) 
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2) Dimensions of XGF-DV8A/DC8A 

 (Unit : mm) 

 
 

 

 

 

 

 



 

 

 

 

 

Warranty and Environmental Policy 
 

 

 

     

 
 

Warranty 
 
 
1. Warranty Period 

 The product you purchased will be guaranteed for 18 months from the date of manufacturing.  
 
2. Scope of Warranty 
   Any trouble or defect occurring for the above-mentioned period will be partially replaced or repaired. However, please note the following 

cases will be excluded from the scope of warranty.  
  

(1) Any trouble attributable to unreasonable condition, environment or handling otherwise specified in the manual,  
(2) Any trouble attributable to others’ products, 
(3) If the product is modified or repaired in any other place not designated by the company,  
(4) Due to unintended purposes 
(5) Owing to the reasons unexpected at the level of the contemporary science and technology when delivered.  
(6) Not attributable to the company; for instance, natural disasters or fire 
 

 
3.  Since the above warranty is limited to PLC unit only, make sure to use the product considering the safety for system configuration or 

applications.  
 
 
 

 

Environmental Policy 
 
 
     LS Industrial Systems Co., Ltd supports and observes the environmental policy as below.  
 
 
 
  

 
LS Industrial Systems considers the 
environmental preservation as the preferential 
management subject and every staff of LS 
Industrial Systems use the reasonable 
endeavors for the pleasurably environmental 
preservation of the earth.   

 
 
     

LS Industrial Systems’ PLC unit is designed to 
protect the environment. For the disposal, 
separate aluminum, iron and synthetic resin 
(cover) from the product as they are reusable.   

Environmental Management About Disposal 
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Korea http://eng.lsis.biz           
   Tel : (82-2)2034-4870/Fax : 82-2-2034-4648 e-mail : cshwang@lsis.biz 
■ LS Industrial Systems Tokyo Office _ Tokyo, Japan 

Address: 16FL. Higashi-Kan. Akasaka Twin Tower 17-22,  
   Akasaka.Monato-ku Tokyo 107-8470. Japan 
   Tel : 81-3-3582-9128/Fax : 81-3-3582-2667 e-mail : jschuna@lsis.biz              
■ LS Industrial Systems(ME) FZE _ Dubai, U.A.E. 

 Address : Jafza View Tower Lob 19, Room 205 Along Sheikh Zayed  
 Road Jebel Aali Free Zone Dubai, United Arab Emirates 
Tel : 971-4-886-5360/Fax : 971-4-886-5361 e-mail : jungyongl@lsis.biz             

■ LS Industrial Systems Shanghai Office _ Shanghai, China 
   Address : Room E-G. 12FL Hiamin Empire Plaza. No.726. West. 
   Yan'an Road Shanghai 200050. P.R. China e-mail : liyong@lsis.com.cn 

Tel : 86-21-5237-9977(609)/Fax : 89-21-5237-7189                 
■ LS Industrial Systems Beijing Office _ Beijing, China  

Address : B-Tower 17FL. Beijing Global Trade Center B/D. No. 36. 
East BeisanHuan-Road. DongCheng-District. Beijing 100013. P.R. China 

   Tel : 86-10-5825-6027(666)/Fax : 86-10-5825-6028 e-mail : xunmj@lsis.com.cn 
■ LS Industrial Systems Guangzhou Office _ Guangzhou, China 

Address : Room 1403.14FL. New Poly Tower. 
2 Zhongshan Liu Road.Guangzhou.P.R China 
Tel : 86-20-8328-6754/Fax : 86-20-8326-6287 e-mail : chenxs@lsis.com.cn 

 
 

■ LS Industrial Systems Chengdu Office _ Chengdu, China 
Address : 12FL. Guodong Buiding. No.52 Jindun  
Road Chengdu.610041. P.R. China 
Tel : 86-28-8612-9151(9226)/Fax : 86-28-8612-9236 e-mail : comysb@lsis.biz  

■ LS Industrial Systems Qingdao Office _ Qingdao, China 
Address : YinHe Bldg. 402 Room No. 2P Shandong Road, 
Qingdao-City,Shandong-province 266071, P.R. China 
Tel : 86-532-8501-6068/Fax : 86-532-8501-6057 e-mail : wangzy@lsis.com.cn 

■ LS Industrial Systems Europe B.V. , Netherlands 
    Address : 1st. Floor, Tupolevlaan 48, 1119NZ, Schiphol-Rijk, The Netherlands 

Tel : +31 (0)20 654 1420/Fax : +31 (0)20 654 1429 e-mail : junshickp@lsis.biz 
■ Wuxi LS Industrial Systems Co., Ltd _ Wuxi, China 

Address : 102-A. National High & New Tech Industrial Development Area.  
Wuxi. Jiangsu. 214028. P.R. China 
Tel : 86-510-8534-6666/Fax : 86-510-8534-4078 e-mail : caidx@lsis.com.cn 

■ Dalian LS Industrial Systems Co., Ltd. _ Dalian, China  
Address : No. 15. Liaohexi 3-Road. Economic and Technical Development zone. 

    Dalian 116600. China 
Tel : 86-411-273-7777/Fax : 86-411-8730-7560 e-mail : cuibx@lsis.com.cn 

 
 
  
 

※ LS Industrial Systems constantly endeavors to improve its product so that
   information in this manual is subject to change without notice. 
 

ⓒ LS Industrial Systems Co., Ltd 2010  All Rights Reserved. 
 

10310000609
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LS values every single customers. 

Quality and service come first at LSIS.  

Always at your service, standing for our customers. 

http://eng.lsis.biz 
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